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Introduction
Artist is a tool for editing molecular structures and estimating thermo physical and transport properties 
from molecular structure directly. Artist contains a structure data bank (ChemDB) currently containing 
over 19000 components.

The core algorithm of Artist is an automatic fragmentation which allows to implement a wide range of 
group contribution methods in a quick and reliable manner. A list of the properties and methods is ap-
pended to this document.

The list of methods comprise mainly group contribution methods – because of the underlying fragmen-
tation algorithm – but also some corresponding states methods (equation of states etc.). 

Artist can additionally be used as retrieval program for components. The Dortmund Data Bank uses a 
component number index and this number has to be found either by name, formula, CAS registry num-
ber and several other techniques. Artist adds the ability to determine the DDB number from the drawn 
structure.
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The Main User Interface

Artist is a typical example for a multi-document program contain multiple drawings in a parent win-
dow. All functions either in the menus, in the tool bars, or in the context menus are operating on the 
drawing in the topmost window.
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The Menus

The File Menu
New: Open a new and empty drawing window

Open: Opens a molecular structures file. The list of supported file 
formats is shown in the appendix.

Close: Close current drawing window. If the structure has been 
modified the program asks if the drawing should be saved.

Load Structure from ChemDB: Read a molecular structure 
from the structure data bank. 

Save Structure in ChemDB: Save a molecular structure in the 
the structure data bank.  If the data bank already contains a struc-
ture a dialog will be displayed for either replacing a structure or 
adding the new structure.

Delete Structure in ChemDB: Removes a structure from the data bank. Artist displays a dialog from 
which the structure to be deleted can be selected.

Common note for ChemDB access functions: Artist opens the standard DDB component selection dia-
log for obtaining the component's DDB number because the structures are indexed (main index) by this 
component number.
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Figure 1: Saving Structures in ChemDB



Load Component List: Component lists are containing DDB code numbers. Files with component 
lists have the extension “.stl”.If a line is selected the molecular structure of the component will be load-
ed and displayed in a new drawing window.

Load NCI Component:Artist comes with the NCI (National Cancer Institute, U.S.A.) structure data 
bank which contains approx. a quarter of a million structures mainly for pharmaceutical components. 
This menu entry allows to load a NCI component by its NCI number.

Append to Compound Definition File: For adding new components Artist provides a dialog which al-
lows to enter name, formula, CAS registry number and molecular weight.
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Figure 2: Deleting Structures From ChemDB

Figure 3: Component List



Artist can provide the molecular weight and the formula. After entering the necessary values (two 
names) the component can be appended either to the private (customer) or to the public (DDBST) data 
bank. Artist automatically updates the necessary files including the component basic file and the struc-
ture data bank.

Save: Stores the current structure in the file it has been loaded from.

Save as: Stores the current drawing in a new file.

Print: Prints the current drawing. This function always shows a print preview first.
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Figure 4: Adding a New Component



Print Setup: Allows to select the printer and its properties

Exit: Closes Artist.

Recent Files: The sub menu is only visible if at least a single file has been loaded and contains the list 
of the recently load files.

“Clear List” removes all entries from this sub menu.
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Figure 5: Print Preview Dialog



The Edit Menu
Undo: Undoes the latest action

Redo: Redoes the latest undone action

Cut: Copies a marked area in the Artist internal buffer and deletes 
the source.

Copy: Copies a marked area in the Artist internal buffer

Paste: Paste a marked area from the Artist internal buffer

Clear: Removes the current drawing

Copy as Meta file: Copies the current drawing as Windows meta 
file to the Windows clipboard

Options: Displays a option 
dialog.

Show Molecule as CTC: 
Displays the current struc-
ture in CTC format (see de-
scription in appendix)

Show Molecule as AI 
Fragment: Displays the 
current structure in a format 

usable for the automatic fragmentation algorithm.

Search in ChemDB as Substructure: This function allows to 
search the molecular structure data bank for components con-
taining the current structure as substructure.
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Figure 6: Options



Search in ChemDB (Exact Match): This function allows to search the structure database for exactly 
matching structures.

This allows to identify the DDB component number for a molecule which is the main index number in 
the Dortmund Data Bank. This list can contain multiple structures if conformers are available.

Search in NCI DB (Exact Match): This function searches the NCI data bank for matching structures.

Search in NCI DB (Fingerprint): This allows to search the NCI data bank for components with same 
(or at least similar) formula.
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Figure 7: ChemDB Substructure Search

Figure 8: Search for Exact Match - Result



The View Menu
The first three entries (“Drawing Tools”, “Menu Shortcuts”, 
“Rotate/Move/Size”) allow to make tool bars visible if they 
have been teared off and closed.

The three other functions allow to start other programs in the DDB Software Package by OLE access. 
These function are only available if the DDB number of the component is available (see page 10 for 
“Search in ChemDB – Exact Match”)

Pure Component Properties: Calling the Dortmund Data Bank and start a search for pure component 
properties of the current molecule.

Mixture Properties Data bank Entries: Calls the Dortmund Data Bank program and retrieves all data 
from mixture properties data banks.

Compound Definition File Entries: Calls the Component Editor and displays the component basic 
file entries (like names, formula, CAS registry number)

The Window Menu
The Window menu contains the standard Windows functions 
for windows like arrangement, switching to the previous and 
next window, closing all or some windows, and a list of all win-
dows.
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The Calculate Menu
Calculate: Display the calculation dialog – see details in 
Estimation of Properties chapter.

Modify Domalski/Hearing Parameters: Displays a dialog where group contribution parameters for 
the Domalski/Hearing models can be modified. Please 

Reaction Enthalpy: Display the dialog for estimating the reaction enthalpy – see chapter Reaction
Enthalpy for details.

Activity Coefficients: Displays the dialog for estimating activity coefficients – see chapter Activity
Coefficients for details.

Group Assignment: Display the dialog for the automatic group assignment see chapter Automatic
Group Assignment for details.

MOPAC: Display the dialog for calling MOPAC, Tinker, and RasMol. See chapter MOPAC, Tinker,
RasMol for details.

Page 12 of 44



Drawing Structures
Selection of atomic symbol

Drawing tools (single bond, double bond, triple bond, wedges, dimethyl group, 
benzene, methyl benzene, trimethyl group, carboxylic acids, aldehydes, nitriles, 
isopropyl, tert-butyl, sulfonate, alkyl chains, nitro, glycol chains)

Rings

Delete bonds and atoms

Delete all hydrogens

Add hydrogens including a simple coordinates generation

Charges (minus, plus, radical, none)

After creating a new drawing windows (by File-New or ) an empty sheet is displayed. 

The drawing tools allow to select some predefined fragments. The most simple fragment is the single 

bond . 

The drawing mode is 'click and drag'. After selecting the position of the start atom of the bond with 
pressing the left mouse key the structure can be drawn by moving the mouse while keeping the mouse 
pressed down.

Artist displays a small green box when the left mouse key is pressed down. This box is the area 
where drawing of the bond can be canceled. The mouse cursor has to be moved inside this box be-
fore the mouse key is released. 
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 The bond itself follows the movement of the mouse while the left mouse key is kept 
down. When releasing the mouse key while the mouse pointer is outside the initial green 
box Artist fixes the bond. 

The green box is also shown when the mouse cursor floats above already drawn atoms 
and bonds. If a new bond is started on an existing atom the bond is fixed to this atom. 

If a fragment has more than a single bond and two atoms there's always one atom dedicated as anchor 
(center) atom which is set with the initial mouse click and an atom connected to the anchor which fol-
lows the mouse movement. The other fragment parts are defined by the position of this atom pair and 
their bond.
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Fragment Management
Artist allows to use drawn structures as fragments. 

The single icons have the following functions.

Define fragment anchor atom. This atom of a fragment is set with the mouse.

The green circle defines the fragment center.

Define an atom connected to the anchor atom which will follow the mouse movement.

This is the yellow circle in the figure above.

Directly use the current structure as fragment 

Save fragment to disk (“.FRA file)

Load fragment 
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Automatic Group Assignment
The core technology of Artist is the automatic fragmentation algorithm which allows to break a 
molecules into groups. The groups are the basis for the implementation of group contribution methods. 

Since almost every method has its own specific list of groups Artist provides a bulk of group assign-
ment schemes separately for each model.

The automatic group assignment can be called from the Calcula-
tion menu or by the icon from the tool bar.

The dialog list all files with group assignments (“.INK” files). 
Many of these “files” are integrated inside the Artist programs. 

A typical result for the fragmentation of bromo benzene by the UNIFAC model is shown here:
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Molecule Description
#DDB=26  Bromobenzene
Comment: 
Group Assignment
Method: UNIFAC.INK

Group assignment was successful and complete

Subgroup number: 64  Maingroup number: 33  Groupname: Br
Atoms: 1  in 1 Group
Subgroup number: 10  Maingroup number: 3  Groupname: AC
Atoms: 2  in 1 Group
Subgroup number: 9  Maingroup number: 3  Groupname: ACH
Atoms: 3 4 5 6 7  in 5 Groups

DDB Encoded Group List:
      3   1064   1010   5009

List of rings
 6 membered aromatic ring found. Atoms: 2 3 4 5 6 7 

Br 1

2
3

4
5

6

7

The group assignment found the UNIFAC subgroups 64 (Bromine), 10 (aromatic carbon with three 
bonds), and 9 (aromatic carbon with two bonds).

The DDB encoded groups (“3   1064   1010   5009”) can be used in the component editor 
(“STOFFEditor”). The “3” determines the number of different groups, “1064” means 1 time the group 
number 64 , “5009” means that group 9 [ACH] has been found five times.
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The group assignment can deliver also a list of ortho/meta/para pairs, a list of rings, a list of chains, and 
the graphical representation of the assignment. The list of rings, chains, and o-,m-,p-pairs are sup-
pressed if no such structural part are present..
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Estimation of Properties
Artist was originally designed for the estimation of pure compo-
nent properties using group contribution methods, Artist now 
contains several dozens of different estimation methods. A list of 
models together with the references can be found in the ap-
pendix. 

The calculation dialog can called either from menu or from an 
icon in the tool bar.

The calculation dialog contains three major parts
1. The list of properties in a tree view with the different models grouped below the properties.

2. A dialog part where additionally needed properties (besides the model specific group contribu-
tions) can be entered. Artist collects result from previous calculations (a “history” of results) 
and allows to use these results as input for other models.

3. The list of results either in a table format or as – in some cases more detailed – text output.

The branch “Selected Methods” can be used to collect methods from different properties branches. This 
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allows to make a “selected methods list” for a even quicker access. The different methods can be added 
by the tree view's context menu entries.

Artist allows to calculate properties by single meth-
ods and by all methods for a property. If the proper-
ty line is selected all methods are calculated in a 
row. If a single method is selected only this single 
method is used.

Some methods need additional input besides the structural information. The list of additionally needed 
properties is displayed in the dialog and the user has to fill the missing information. If data are missing 
and a  complete property calculation is started the methods with missing values will fail. 

Artist provides a history of all results calculated or entered before and from the pure component basic 
file (which are e. g. critical data, see component editor for more details).

Artist presents the estimation results in two different modes – a table and a text output.

The text output

contains additional information – especially the list of groups from the automatic fragmentation.
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Figure 10: Property Estimation - Text Result



The table output

is more concise and allows to copy the result to a spread sheet program. Results can also be stored in 
the DDB parameter data bank (ParameterDB) or as Aspen INP file (selected properties only).

Storing Results in the ParameterDB
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Figure 11: Property Estimation - Table Output



The dialog allows to replace or delete already stored sets and to add the current result as a new data set. 
It also allows to alter some of the data set entries (Component, Author, Value, Comment). 

This dialog only allows to store values in a private (customer) data base. The public datasets (delivered 
from DDBST GmbH) cannot be modified or removed here.

The values stored in the ParameterDB will be available for fur-
ther calculations.

Storing Results as Aspen INP File

Artist allows to store 

● Critical temperature, pressure, volume

● Normal boiling point

● Melting temperature

● Heat of formation
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Figure 12: Property Estimation - Storing Results in Parameter Data Bank



● Acentric Factor

● UNIQUAC r and q

Artist allows to export only single values of each property for a component. The result grid contains 
check boxes which allow to select the values intended for export.
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Reaction Enthalpy

Artist allows to calculate the reaction enthalpy from estimated and known heats of 
formation. The calculation dialog is called from the 'Calculate' menu – 'Reaction 
Enthalpy' or by the icon in the tool bar. The menu entry is only activated if three 
of more structures have been drawn or loaded.

Figure 13: Reaction Enthalpy Calculation

All components are listed initially in the “Available Components” grid. Three types of data have to be 
provided.

1. The heat of formation of the components – which can be estimated by the Domalski/Hearing 
method, typed, or search in the Dortmund Data Bank.
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2. The state of the component – liquid, gas, solid. This determines the result of the Domalski/Hearing 
method.

3. The number of moles for all components.

The next step is the assignment of molecules as educts and products. This can be done by selecting the 
component in the main grid and using the green and red triangle to add and remove them from the sub 
grids or by drag and drop. If all data are available the  button starts the calculation and displays the re-
sult.

Search of Heats of Formation in the Dortmund Data Bank

The button starts a search in the pure component properties 

(PCP) branch of the Dortmund Data Bank for heats of formation of the components in the reaction en-
thalpy dialog.

Only a single heat of formation 
can be selected for a specific 
component. The links “[230]” etc. 
display the reference of the heat of 
formation.
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Figure 14: Search Heats of Formation in Dortmund Data Bank



Activity Coefficients
Artist allows to calculate activity coefficients of binary and 
higher mixtures with the activity coefficient models 

● original UNIFAC

● modified UNIFAC (Dortmund)

● modified UNIFAC (Lyngby)

● ASOG

Figure 15: Activity Coefficient Calculation

The activity coefficient dialog automatically uses all components currently displayed and performs an 
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automatic fragmentation for the chosen model. The groups are shown encoded – e. g. “4002” means 4 
times sub group no. 2.

Two calculation modes are available.

1. Calculate activity coefficients for a list of compositions for a constant temperature

2. Calculate activity coefficients for a list of temperatures for a constant composition

The button opens a dialog where the composition can be specified.

This dialog allows to keep some compositions constant or to set some composition in a specified ratio. 
The other compositions are calculated as equally distributed points.
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Figure 16: Composition Settings



MOPAC, Tinker, RasMol

We cannot distribute neither MOPAC nor Tinker and RasMol the 
user has to download the programs from the Internet. All these 
programs are freely available (MOPAC at least up to version 7).

MOPAC 

Artist can use MOPAC for some calculations and for structure 
optimization. Artist has been tested to work MOPAC version 7, the last freely available version.

Figure 17: MOPAC Interfacing

Since MOPAC is a standalone program the first step for using the 
program is defining its location in Artist.
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Artist does not much more than writing a MOPAC compatible molecular structure file (shown in the 
dialog), calling MOPAC by command line and presenting the results. For a description of the different 
options please use the MOPAC manuals.

The button  allows to load the coordinates generated by MOPAC.

Tinker

Tinker is a molecular mechanics programs used in Artist for generating 3D structures. The location of 
the “minimize.exe” program and the location of the “mm3.prm” have to be specified before Tinker can 
be used.

The button  can be used to read the coordinates generated by Tinker.

RasMol

RasMol is a rather simple, but free, display program for chemical structures. Before first use the loca-
tion of the program has to be specified.
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Model Quality
Artist contains informations on mean deviation for different models estimating normal boiling points, 
critical temperature, critical pressure, and critical volume.

The quality dialogs can be called either by the  button from the main dialog or by the 
button from the calculation dialog.

The data bank contains quality information for component classes. The current atom is assigned to 
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Figure 18: Quality Data Bank



these classes and the stored information for the appropriate component classes. The component classes 
are organized hierarchical. There are comprehensive classes like “Hydrocarbons” and more detailed 
classes like “Aromatic Hydrocarbons”.The AAD (average absolute deviation) is given in Kelvin, the 
“Component Count” column displays the number of tested components and the “Quality” column gives 
a (quite arbitrary) comment on the quality.
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Appendix

File Formats
Artist allows to store four and read four file formats. Readable formats are

1. The proprietary DDBST format with the extension “.CTC”. 

2. The MOL format “.MOL” defined by MDL Information Systems  (http://www.mdli.com/). 

3. The Tinker “.XYZ” format.

4. The COSMO formats from Gaussian and Turbomole

Writable formats are

1. The proprietary DDBST format with the extension “.CTC”. 

2. The MOL format “.MOL” defined by MDL Information Systems  (http://www.mdli.com/). 

3. The MOPAC-Z format 

4. The Gaussian “.gjf” format.

The format of the MOL  format can be obtained from MDL 
(http://www.mdli.com/solutions/white_papers/ctfile_formats.jsp).

The CTC File Format
The CTC format is specially designed to match the requirements of the program Artist with respect to 
storing molecular structures. It is a simple tagged format in pure ASCII. It can be viewed and edited by 
simple editors such as Notepad or UltraEdit.

The program uses the following tags:

Tag Description

#ATOMS list and description of atoms in the molecule

#BONDS list and description of bonds between the atoms

#CAS CAS registry number of the component

#FORMULA empirical formula of the component

#ENAME English name of the component

#TIME file creation time

#PROGRAM program the file was created with

#COMMENT comment
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Tag Description

#FILE original filename

These tags start blocks within the file. Blocks are ended by another tag or the end of file. There is no 
special order in which the blocks must appear.

 #ATOMS
This block contains a list and description of the atoms in the molecule. Hydrogen atoms can be includ-
ed or may be omitted. The first line must contain the number of atoms in the molecule. The following 
lines, one for each atom, contain the following entries separated by at least one blank character:

• x-, y- and z-coordinate (Cartesian).

• atomic symbol. Only symbols from the standard PSE are allowed. Especially, functional groups like 
COOH or NO2 are not legal entries.

• Charge or radical. The following predefined numbers are used to encode the different types of 
charges or radicals:

• 0 → no charge, no radical
• 1 → charge +3
• 2 → charge +2
• 3 → charge +1
• 4 → radical
• 5 → charge -1
• 6 → charge -2
• 7 → charge -3
The same way of encoding is used in mol files by MDL (Molecular Design). Additional number 
are

• 13 → charge +4
• 14 → charge +5
• 11 → charge +6
• 15 → charge -4
• 16 → charge -5
• 17 → charge -6

• mass differences to the most common isotope to specify different isotopes.

• chemical environment. The following environment are defined:

• K → aliphatic chain
• R → aliphatic ring
• A → aromatic system
• N → non-aromatic neighborhood
• C → aromatic or ring (cyclic neighborhood)
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• * → not specified
• molecule number (a ctc structure can contain multiple structures)

#BONDS
This block contains a list and description of the bonds between the atoms. The first line must contain 
the number of different bonds, double and triple bonds are counted as one bond. The following lines, 
one for each bond, contain the following entries separated by at least one blank character:

• atom counter of the first atom.

• atom counter of the second atom.

• bond multiplicity (1 – single bond, 2 – double bond, 3 – triple bond)

• bond orientation allows simple coding of stereo chemistry.

•  0 → not specified
•  1 → in plane
•  5 → in front of plane
•  6 → behind plane

• chemical environment in format %c. The following environment are used:

• K → aliphatic chain
• R → aliphatic ring
• A → aromatic system
• N → non-aromatic neighborhood
• C → aromatic or ring (cyclic neighborhood)
• * → not specified

#CAS
This block contains the CAS registry number of the component.

#FORMULA
This block contains the empirical formula of the component.

#ENAME
This block contains the English name of the component.

#DATE
This block contains the file creation date. The format is (day. Month. year). 

#TIME
This block contains the file creation time as the only entry. The format is (hour: minute: second). 

#PROGRAM
This block contains the name of the program the file was created with as the only entry.

#COMMENT
This block contains comments in free format (single line)
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#FILE 
This block contains the original filename.

Examples:
The following examples illustrate the use of the ctc format.

Ethanol (hydrogen atoms omitted)
#DDB
11
#DATE
20.6.2000
#TIME
19:50:59
#ATOMS
3
    87.97        35         0  C  0  0 *  1
       35     42.93     14.03  O  0  0 *  1
    65.88     48.36     23.63  C  0  0 *  1
#BONDS
2
 1  3  1  1 *
 2  3  1  1 *

Ethyl benzene (hydrogen atoms included)
#DDB
25
#DATE
20.6.2000
#TIME
19:53:30
#ATOMS
18
    149.4     59.29     41.23  C  0  0 *  1
    68.11     116.3     31.62  H  0  0 *  1
    171.1     113.6     93.87  C  0  0 *  1
    224.4     82.79     44.89  C  0  0 *  1
    238.7     131.1     93.24  H  0  0 *  1
       35     126.7     77.62  H  0  0 *  1
    92.86     98.73     125.6  H  0  0 *  1
    68.21     124.8     65.88  C  0  0 *  1
    200.3        35         0  H  0  0 *  1
    257.4     80.93     33.24  H  0  0 *  1
    192.2     56.86     26.11  C  0  0 *  1
      163     135.4       120  H  0  0 *  1
    124.6     39.28     26.76  H  0  0 *  1
       77     58.97     87.07  H  0  0 *  1
    138.9     87.63      75.1  C  0  0 *  1
    213.9     111.1     78.76  C  0  0 *  1
    84.01       156      70.2  H  0  0 *  1
     92.8     90.24     91.39  C  0  0 *  1
#BONDS

Page 36 of 44



18
 4 10  1  1 *
 1 13  1  1 *
11  9  1  1 *
 3 12  1  1 *
 4 11  1  1 *
 8 17  1  1 *
 8  2  1  1 *
 8  6  1  1 *
 4 16  2  1 *
 1 15  1  1 *
16  5  1  1 *
11  1  2  1 *
 3 15  2  1 *
 8 18  1  1 *
15 18  1  1 *
16  3  1  1 *
18  7  1  1 *
18 14  1  1 *
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